Notice

The information contained in this document is subject to change without notice.

Agilent Technologies makes no warranty of any kind with regard to this material, including, but not limited to, the implied warranties of merchantability and fitness for a particular purpose. Agilent Technologies shall not be liable for errors contained herein or for incidental or consequential damages in connection with the furnishing, performance, or use of this material.

Warranty

A copy of the specific warranty terms that apply to this software product is available upon request from your Agilent Technologies representative.

Restricted Rights Legend

Use, duplication or disclosure by the U. S. Government is subject to restrictions as set forth in subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 for DoD agencies, and subparagraphs (c) (1) and (c) (2) of the Commercial Computer Software Restricted Rights clause at FAR 52.227-19 for other agencies.

Agilent Technologies
395 Page Mill Road
Palo Alto, CA 94304 U.S.A.


Acknowledgments

Mentor Graphics is a trademark of Mentor Graphics Corporation in the U.S. and other countries.

Microsoft®, Windows®, MS Windows®, Windows NT®, and MS-DOS® are U.S. registered trademarks of Microsoft Corporation.

Pentium® is a U.S. registered trademark of Intel Corporation.

PostScript® and Acrobat® are trademarks of Adobe Systems Incorporated.

UNIX® is a registered trademark of the Open Group.
Contents

1 Connection Manager Basics
   Connection Manager Implements Connected Solutions ........................................... 1-1
   Connection Manager at a Glance ......................................................................... 1-1
   The Process Environment .................................................................................. 1-1
   The Connection Manager Client ..................................................................... 1-2

2 Configuring the Server and Accessing the Client
   Before You Begin ................................................................................................ 2-1
   Configuring the Server IO .................................................................................. 2-2
   Choosing a LAN Interface .................................................................................. 2-3
   Connecting Instruments to the Server through the LAN .................................... 2-5
   Choosing a GPIB Interface .............................................................................. 2-8
   Connecting Instruments to the Server Over GPIB ............................................. 2-13
   Accessing the Client and Exploring Connected Hardware ............................... 2-15
   Starting the Connection Manager Client .......................................................... 2-15
   Selecting a Server Workstation and Connection Port ....................................... 2-17
   Controls Common to all Measurements ............................................................. 2-19

3 Performing Connected Measurements
   Introduction ......................................................................................................... 3-1
   Instrument Discovery .......................................................................................... 3-1
   Making a 2-Port S-Parameter Measurement ....................................................... 3-5
   Displaying the Data ............................................................................................ 3-9
   Exporting a File .................................................................................................. 3-11
   3-Port S-Parameter Measurements .................................................................... 3-13
   Select Instrument ............................................................................................... 3-14
   Select Measurement .......................................................................................... 3-15
   Export Data ........................................................................................................ 3-15
   Save Dataset ...................................................................................................... 3-15
   Measure .............................................................................................................. 3-15
   Measurement Results ......................................................................................... 3-16
   2-Port Power Swept S-Parameter Measurements .............................................. 3-18
   Select Instrument ............................................................................................... 3-21
   Select Power Settings ....................................................................................... 3-21
   Select Measurement .......................................................................................... 3-22
   Export Data ........................................................................................................ 3-22
   Save Dataset ...................................................................................................... 3-23
   Measure .............................................................................................................. 3-23
   Measurement Results ......................................................................................... 3-23
   Spectrum Measurements ..................................................................................... 3-25
4 Operational and Functional Concepts

Understanding Client-Server Architecture .................................................. 4-1
Understanding the Connection Manager Server ........................................... 4-1
  The Server Process Construction ............................................................... 4-2
  Connection Manager Server Requirements ............................................... 4-8
  Software ...................................................................................................... 4-9
  Removing the Connection Manager Server from the Server Workstation .... 4-10
Understanding the Connection Manager Client ............................................ 4-10
File Menu ..................................................................................................... 4-11
Server Menu ............................................................................................... 4-12
Instruments Menu ....................................................................................... 4-12
Measurements Menu .................................................................................. 4-16
Troubleshooting .......................................................................................... 4-16
  Communication Problems with Older Instruments ................................... 4-16
  Problems with the Connection Manager Server ....................................... 4-18

Index
Chapter 1: Connection Manager Basics

Connection Manager Implements Connected Solutions

Connection Manager (CM) is the Advanced Design System (ADS) implementation of Agilent Technologies Connected Solutions.

Connected Solutions refers to the integration of ADS software and specific Agilent instruments (signal generators and signal analyzers) into a solution that enables new design and verification capabilities. It combines simulation and measurement, and allows the seamless sharing of signals, measurements, algorithms, and data between the simulation and measurement domains.

Using Connection Manager, you can:

• access and control instruments from ADS dialogs
• measure devices and construct ADS data sets from the measurement data
• create simulation models based on measured data
• use real-time instrument-generated stimulus and measurement during simulations

Connection Manager at a Glance

The Process Environment

The Connection Manager employs a client-server environment, leveraging the Microsoft's .NET framework to dynamically attach libraries and invoke the libraries functions.

For more information, see “The Server Process Construction” on page 4-2.

The Connection Manager Server

Connection Manager server provides dynamic access and control of remote instruments, measurement configuration.
Connection Manager Basics

Refer to “Understanding the Connection Manager Server” on page 4-1 for more information.

The Connection Manager Client

The Connection Manager client provides the interface between ADS and the Connection Manager server's functionality and extensibility. The client allows the ADS user to:

- dynamically manage data
- configure the server
- control input and output
- make device measurements

Refer to “Understanding the Connection Manager Client” on page 4-10 for more information.
Chapter 2: Configuring the Server and Accessing the Client

Before You Begin

Prior to using Connection Manager for the first time, you must configure the server. This process consists of the following tasks:

• configuring the IO configuration
• connecting instruments to the server

This chapter explains how to configure the Connection Manager and access the user interface. For more detailed information on IO configuration, refer to the documentation for the IO libraries (click the IO icon in the tool bar, then click View Documentation).

After configuring the server IO, you will learn how to access the client and use it to explore connected instruments.

The following section provides instructions for configuring a LAN and GPIB interface.

Note For more information about configuring the Agilent IO Libraries, see “Configuring IO Interfaces” in the Agilent IO Libraries Installation and Configuration Guide for Windows manual. You can find the PDF of this manual at: http://www.agilent.com/find/iolib.
Configuring the Server and Accessing the Client

**Note** For information about using National Instruments IO interface cards with Agilent IO Libraries refer to Agilent I/O Libraries and NI Software at: http://scmkt.soco.agilent.com/field/service/signal/psa/Known_Problems/Ag_n_ni.doc

Use this procedure at initial software setup or whenever you want to:

- add or remove an IO interface
- add or remove a network connected instrument

**Configuring the Server IO**

Prior to using Connection Manager for the first time, you must configure the server IO on the workstation that is running the server.

This process consists of the following tasks:

- choosing an IO interface
- connecting instruments to the server through the chosen interface

The following section provides simplified instructions to configure a LAN interface. To configure a GPIB interface, see “Choosing a GPIB Interface” on page 2-8. To configure other interfaces, refer to “Before You Begin” on page 2-1.
Choosing a LAN Interface

1. In the server's Windows system tray, click the IO icon.
2. From the menu picks, select Run IO Config.
3. To automatically execute a server scan of available interfaces, press Auto Config.
4. Select the TCPIP0 interface listed in the Configured Interfaces group box.
5. Click **OK**.

If you encounter a problem

Ensure the following conditions are met:

- The server is connected to the LAN
- The LAN is operational

The server’s LAN interface configuration is now complete.

To connect instrumentation to the Connection Manager server, see “Connecting Instruments to the Server through the LAN” on page 2-5.

To exit the IO configuration without connecting instruments to the server, click **OK**.
Connecting Instruments to the Server through the LAN

1. In the IO Config dialog, with the TCPIP0 interface highlighted in the Configured Interface group box, click Edit.

2. In the LAN Client dialog, click Edit VISA Config.

3. In the TCPIP devices dialog, click Add device.
4. In the Add a TCPIP device dialog's **Machine Name/IP** field, enter the IP address of the instrument you would like to connect to the server.

5. Click **OK**.

6. In the TCPIP devices dialog, click **OK**.
7. In the LAN client dialog, click **OK**.
8. In the IO Config dialog, click **OK**.

**If you encounter a problem**

Ensure the following conditions are met:

- server is connected to the LAN
- instrument is connected to the LAN
- instrument line power is switched on
- LAN is operational

This completes the LAN instrumentation connection procedure.

To configure a GPIB interface, see “Choosing a GPIB Interface” on page 2-8.

To start the Connection Manager client, see “Accessing the Client and Exploring Connected Hardware” on page 2-15.
Choosing a GPIB Interface

If you are configuring a GPIB connection for measurement hardware that is currently configured as a LAN connection on this computer, you must first remove the LAN configuration. To remove the LAN connection, complete the following steps:

1. In the Windows system tray, click IO.

2. From the menu picks, click Run IO Config.

3. In the Configured Interfaces group box, highlight the LAN interface.

4. Click Remove.

5. Cycle line power on the instrumentation connected to the server.

Configuring a GPIB 82350 PCI Interface:

To configure the GPIB interface, complete the following steps.

1. Connect your GPIB instruments to the GPIB interface in the computer.

2. Power on the PC and the instruments.
3. In the server's Windows system tray, click the IO icon.

4. From the menu picks, click Run IO Config.

5. To automatically execute a server scan of the available interfaces, press Auto Config.
6. Select the 82350 PCI GPIB interface from the Available Interface Types box.
7. In the Configured Interfaces group box, highlight the Visa Name GPIB1 and click **Edit**.
8. Click **Edit VISA Config...** to verify that the server recognizes the GPIB instrument.

This displays the Show Devices dialog.

The settings in the Show Devices dialog determine how Connection Manager discovers connected instruments. You can add instruments to the list manually.
by selecting “Add device” or automatically by selecting Auto Add devices. If the “Identify devices at run-time” checkbox is selected a query to identify all configured instruments causes the VISA library to search the instrument interface to find instruments. If this box is not selected, instrument discovery is limited to devices listed in the “Devices present on interface GPIB1:” list found in the Show Devices dialog.

Note  The Identify devices at run-time checkbox is selected as the default setting.

If You Encounter a Problem
Ensure the following conditions are met:
• server is connected to the instrument
• instrument line power is switched on

Proceeding with the Configuration
The server’s GPIB interface configuration is now complete.
To exit the IO configuration without connecting instruments to the server, click OK.

Connecting Instruments to the Server Over GPIB
To verify the server recognized your GPIB instrument:
1. Click the IO icon in the task bar and Run VISA Assistant or click Start > Programs > Agilent IO Libraries and select VISA Assistant.
2. VISA Assistant lists your GPIB instrument. In this example, the instrument GPIB address is 16.

3. Close VISA Assistant.

This completes the GPIB instrumentation connection procedure.

To configure another IO or for more information on IO configuration, refer to “Before You Begin” on page 2-1.

To start the Connection Manager client, see “Accessing the Client and Exploring Connected Hardware” on page 2-15.
Accessing the Client and Exploring Connected Hardware

Starting the Connection Manager Client

To start the Connection Manager client, follow these steps.

1. From the ADS Schematic window, select Tools > Connection Manager Client > Start Connection Manager Client.
Configuring the Server and Accessing the Client

When the client starts, a Getting Started dialog box is displayed. This dialog assists you in selecting which menu is used to perform which task.

2. Click **OK** to dismiss this dialog box.

   Selecting the Don't show this dialog box again checkbox prevents this dialog from appearing again.
Selecting a Server Workstation and Connection Port

The client needs TCP/IP network connectivity to a computer running the Connection Manager server.

To specify a machine as the Connection Manager server, follow these steps.

1. From the Connection Manager Client main window, click Server > Set Server.

A dialog box with two data entry fields appears: one labeled Enter the server IP Address or DNS name, the other labeled Enter the remote port #. Use these data entry fields to set the program's connection to a specific port on a specific server. The contents of this dialog become the default for the rest of the client session.

Values entered in the upper field specify the workstation running the Connection Manager server.

2. Enter an IP address or a DNS (host) name in the upper data entry field.
Configuring the Server and Accessing the Client

You can specify the server name using an IP address or a host name. An IP address takes the form of a series of period-separated numeric entries representing a workstation, (i.e., 162.156.24.58). You can find the IP address of a Windows workstation by typing the command `ipconfig -all` into a command line window.

You can also specify the server using either the short form or fully qualified DNS (Domain Name Server) host name. If the client and server workstations have been configured to do so, you can use the short form of DNS name, like “myserver”, which is short form of the fully qualified DNS name “myserver.mycompany.com”. You can find the server workstation host name by typing the command `hostname` into a command window. The default server entry is localhost, meaning the client and server are on the same workstation.

3. Enter a Port number in the lower data entry field.

The port number is an end point the server uses to allow Connection Manager client connections to particular services. A port number is a unique number that allows a client to hold a conversation with a particular server. The default port is 4790. For information on how to change the port number refer to “The Connection Manager Server” on page 4-6. You can view the currently active ports on the server by typing the command `netstat -a` into a command line window. This yields a list of bound ports including the Connection Manager server ports:

```
TCP    dudetop:4790           0.0.0.0:0              LISTENING
TCP    dudetop:4791           0.0.0.0:0              LISTENING
```

The checkbox labeled Do not prompt me again enables you to select whether the server connection dialog displays when you select any of the entries in the Server, Instruments, or Measurements menus. Selecting this checkbox directs all further activities to the server identified when you dismissed the Set Server dialog box. Leaving this box cleared, causes the CM client to display the Set Server dialog every time you select from the Server, Instruments, or Measurements menus.

---

**Note**  In a case where a client is connected to several different servers, leave this checkbox unselected. You can have multiple instances of the measurement panels and discovery dialogs pointed to multiple servers.
The information governing whether the server dialog is displayed or not is stored in the XML file named CM_InitConfig.xml under your `<ADS Home>/hpessof/config` directory. The file contains the following command line:

```
<MsmtClientInitConfig StartupDlgChecked="0" RemoteHost="localhost" Port="4790" ServerDlgChecked="0"/>
```

The `ServerDlgChecked` value determines whether the server dialog is displayed or not. Entering “0” displays the dialog, entering “1” suppresses it.

This file also records the default value of server host and port number.

**Controls Common to all Measurements**

Connection Manager uses dialog boxes to configure instruments, execute measurements, and collect and format ADS data sets. Many of these measurement dialogs have a common subset of controls that are used to collect the information needed to record an ADS dataset. Some measurement dialogs provide a limited set of controls to setup an instrument and gather data from a manually configured instrument. Some measurements do not require the use of these programmatic controls.

For example, the S-parameter measurements assume a valid network analyzer calibration. Changing an instrument configuration programatically could invalidate the calibration. In this instance, the measurement control dialog omits controls that could cause the instrument to make a measurement without a valid calibration.

**The Select Instrument Group**

Starting from the top of the Measurement dialog boxes, there is a group labeled Select Instrument. Although all Measurement dialog boxes have a Select Instrument group, not all dialog boxes expose the same controls.

![Select Instrument](image)

Every Measurement dialog box contains a drop-down list to select an instrument at a specific bus or network address. Use the Select Instrument drop-down list to choose an instrument for a given measurement. This is the same information found in the Remote Instrument Explorer. Click Refresh to get the latest view of the server configuration.
Configuring the Server and Accessing the Client

The checkbox labeled Override instrument model check enables you to determine whether the measurement queries an instrument for its identification string and verifies that the instrument is a particular model number or belongs to a particular family. This identification takes place once at the beginning of the measurement.

If you know that a measurement needs to take place only on a certain model number of instrument, or family of instruments in the case of measurements that talk to instrument families, you would want to leave this box cleared. If you know you have an instrument whose instruction set is compatible with a given instrument or family, but is not specifically listed in the measurement, and you want to use the unlisted instrument, you would check this box.

For instance, if you want to make a voltage waveform measurement, and you have an instrument that is instruction set compatible with an Agilent 86100, you would use the unlisted oscilloscope, knowing that the measurement will work based on the knowledge that the unlisted instrument has an instruction set compatible with the 86100.

**Note** Measurements have only been tested with the instruments identified in the measurement window. Using an unlisted instrument may provide inaccurate results.

Some Select Instrument sections contain a checkbox labeled Reset Instrument on Initialization. If checked the box resets the instrument to a known state before beginning any new measurement. This happens only once at the beginning of a measurement. Check this box in cases where the instructions a measurement sends to an instrument are not valid for the way the instrument is currently configured.

**The Save Dataset Group**

This group has controls necessary to properly construct an ADS dataset from measured data.

The entry field labeled Dataset Name contains the file name of the destination ADS dataset. Every measurement creates a temporary dataset file in the project data directory named __cmui.ds. When a measurement completes successfully, __cmui.ds
is renamed to the entry specified in the Dataset Name entry field. In the case where a measurement does not run to completion, the __cmui.ds file remains in the project data directory to try to preserve as much information as possible.

In addition to being able to type the name of a dataset file into the Dataset Name field, the Browse... button will display a file selection dialog that you may use to select an existing data or specify a new one. In the case where you specify the name of an existing dataset, its contents will be replaced with the contents of a new measurement.

The Block Name field holds the name of a containing variable that holds the actual measurement variables. This is used to allow you to select measurement values of the same name from different measurement runs. Normally, a measurement creates a data set holding a single block filled with all the variables representing the various pieces of measured data, but there are occasions where this is not be true.

As an example, let's say that you made an S11 measurement that gathered all the measurement data, but the destination dataset was not written, possibly because some other application has the destination dataset file locked. That data would be stored in __cmui.ds in a variable named s1_1 in a block named in the Block Name field. When the condition causing the data set not to be written is corrected, you could take another S11 measurement, using a different block name, and both blocks would contain a variable named s1_1. In the Data Display page where you want to display the data, specify Block1.s1_1 (for instance) to display the result of the first measurement and Block2.s1_1 to display the result of the second measurement.

**Note**  It is necessary to use different block names. Currently, datasets do not have the capability to overwrite a variable in an existing dataset.

Though not specifically part of the dataset group, clicking the Measurement button confirms the measurement configuration before executing the hardware commands. If so, the client tells the server to make the measurement, sending the information gathered in the measurement panel as configuration data.
Configuring the Server and Accessing the Client
Chapter 3: Performing Connected Measurements

Introduction

The Connection Manager Measurements menu provides several interactive interfaces. These interfaces enable you to easily configure and perform some simple measurements that are made available on the server.

The measurement windows roughly correspond to the kind of instrument that is commonly used to make a particular measurement (i.e., an oscilloscope in the case of a voltage waveform measurement).

These windows are designed to be measurement-specific, as opposed to instrument specific. Because the measurement-specific windows are not used to interact with schematics, these measurement windows use the multiple document interface presentation. This allows the client window to manage and group the measurement windows.

The Measurement menu of Connection Manager contains four selections:

- 2-Port Power Swept S-Parameters
- S-Parameters
- Spectrum
- Voltage Waveform

Instrument Discovery

Connection Manager discovery tools provide you with information about the server workstation. There are two things to remember:

- All instruments must connect to or through the server workstation
- When discussing Agilent IO libraries configuration, it is intended for the configuration to be performed on the server workstation

The Connection Manager client and server commonly reside on the same physical machine. Because of this, instrument configuration may take place on the same workstation that the client resides.
Performing Connected Measurements

**Note** If you have not already done so, follow the steps in “Choosing a LAN Interface” on page 2-3 to configure your Agilent IO Libraries.

Once Connection Manager server IO is configured, we can discuss the client’s dynamic discovery capabilities.

To start the Connection Manager client:

1. From the ADS Main window open an ADS project.
2. From an ADS Schematic window, select **Tools > Connection Manager Client > Start Connection Manager Client**, to open the Connection Manager client window.

![Connection Manager Client Window](image)

Figure 3-1. Connection Manager Client Window

3. From the Connection Manager Client window, select **Instruments > Remote Instrument Explorer...** to access the Set Server dialog box.

![Set-Server Dialog](image)

3-2 Instrument Discovery
4. Enter the DNS host name or IP address of the workstation on which the Connection Manager server is running.

5. Enter the port number on which the server listens for incoming requests.

**Note** By default the port number is 4790. For information on changing the port refer to “The Connection Manager Server” on page 4-6.

6. Click **OK** to access the Remote Instrument Explorer dialog box.

This dialog box shows the Visa Resource identifiers of all instruments that are currently connected to the workstation running the Connection Manager server. A Visa Resource identifier can uniquely identify an instrument among all the instruments connected to the workstation through all available interfaces.

To map the Visa Resource identifiers to the associated instrument model number:

1. Select one or more of the Visa Resource entries.
2. Click the Query Selected Instruments’ IDs button.
Performing Connected Measurements

This tells the Connection Manager server to send the IEEE 488.2 standard command for instrument identification *IDN? to each of the selected instruments.

**Note** Some older instruments cannot respond to *IDN? and show an error, usually a time out, in the Instrument ID field.

You can see that two instruments have been discovered on the GPIB0 interface, a Hewlett-Packard 8753E, and a Hewlett-Packard E4406A.

**Note** Though the Visa Resource column lists the instruments as named using a library, it is not usually necessary to remember the library resource identifier syntax. The measurements that use these instrument resource identifiers display them in a selection control.

Clicking the Refresh button will cause the server to repopulate the list after adding or removing instruments from the server.
Making a 2-Port S-Parameter Measurement

The S-parameter measurement panels are used to gather S-parameter measurement data from network analyzers that have already been configured to the correct frequency ranges, power levels, and calibration setups. In all cases, the instrument must return both amplitude and phase information.

Note: Scalar analyzers do not provide information in a format suitable for use with ADS.

Measurement Selections

The S-parameter measurement panels have a control group labeled Measurement Selections. This group of controls contains a number of selections appropriate for the type of instrument with which the server is trying to communicate. Currently, there are measurements that define groups for use with 2- and 3-port network analyzers.

The format of the variable names stored in an S-parameter data set depend on the measurements selected. There are two variable name formats used in S-parameter data sets:

- a matrix notation
- a non-matrix notation

The matrix notation is used when you select all measurements needed to fully populate a matrix for a given number of ports, the minimum number being two ports. The notation for a 2-port measurement will contain variables names S[1,1], S[1,2], S[2,1], and S[2,2]. 3-port matrices contain S[1,1], S[1,2], S[1,3], S[2,1], S[2,2], S[2,3], S[3,1], S[3,2], S[3,3].

For individual S-parameter measurements, or measurements that do not contain all of the 2 or 3-port data, the variable names take the form s1_1, s1_2, s2_1, s2_2 and so forth. It is necessary to differentiate between a fully-populated and a partially-populated matrix. Expression evaluators in the Data Display Server and in simulation components that evaluate dataset expressions make simplifying assumptions when they encounter variables named using matrix notation. Those assumptions enable faster lookup for matrix variables and depend on a particular layout and ordering in the stored data. The absence of data within the matrix data cause the matrix evaluation expressions to fail.
Performing Connected Measurements

To make a 2-port S-parameter measurement, complete the following steps.

1. From the Connection Manager client window, select **Measurements > S-Parameters > 8753/8722/8720/8719 Network Analyzer Family**.

   This opens the S-Parameter Measurement – 8753/8722/8720/8719 Network Analyzer Family measurement dialog box.
2. Select **GPIB0::16::INSTR** from the Select Instrument drop-down menu.

3. For this measurement, deselect all measurements except S11.

4. Fill in the Dataset Name and Block Name fields.
Performing Connected Measurements

Use the Browse... button to select an existing file, or type in the file name for a file you want to create. The Block Name field is used to differentiate two pieces of data that have the same variable names.

5. Click Measure to send the client information in the Measurement dialog box to the server workstation.

The server processes the request and returns the results. The first time a measurement is run, the server imports the drivers and libraries necessary for the proper operation of the measurement. The results are stored in the dataset file. These stored values can be used by Data Display and/or in a simulation.

Note: While the measurement is running, the Measurement window is disabled. Upon completion, a Measurement complete window appears. Click OK to dismiss.
Displaying the Data

To display the data in a Data Display window:

1. From the toolbar in the ADS Schematic window select **Window > New Data Display**.
2. Select the **Doc8753** dataset.
3. Click the **Rectangular Plot** button, then click inside the Data Display window to open the **Plot Traces & Attributes** dialog box.
Performing Connected Measurements

**Note**  The measurement variable is $s_{1\_1}$. If only part of an S-parameter matrix is stored, the variable names cannot use the standard matrix notation. If all four S-parameters are selected, and Measure is pressed again, the dataset variable naming conforms to the matrix notation.
The following illustration shows the result of an S11 measurement displayed in the Data Display window.

**Exporting a File**

Besides storing measured S-parameter data in a data set, you can also export it to a text file in either CitiFile or Touchstone formats.

To do this:

1. Click the **Export to Text File** check box.
2. Select the file type to export from the **FileType** drop-down list.
Performing Connected Measurements

3. Use the Browse... button to select an existing file, or type the file name for a file you want to create.

![Browse dialog](image)

4. Selecting **Measure** now records the data into the selected text file, as well as, recording it into the dataset.

The Connection Manager Client is used in conjunction with an ADS project. The datasets and other files generated from measurements reference the ADS project and project data directories.

The client caches the discovery dialogs contents. For example, start the Remote Instrument Explorer and point it at a specific workstation (i.e., myserver), then click the close icon in the title bar to dismiss it. The next time the Remote Instrument Explorer is opened and pointed at myserver, the client recalls the last information stored on the Connection Manager client about myserver’s contents. This prevents a potentially time-consuming conversation between the client and server every time a discovery dialog is opened.

**Note** To get the latest view of the server configuration, press the client dialog Refresh button.
3-Port S-Parameter Measurements

3-port S-parameter measurements are available for the Agilent E88XX/E83XX/N338X PNA Series network analyzers. Choose Measurements > S-Parameters > E88XX/E83XX/N338X Network Analyzer Family to access the S-Parameter Measurement window shown in Figure 3-3.

Figure 3-2. Accessing S-Parameter Measurement Window in Connection Manager

The S-Parameter Measurement - E88XX/ E83XX/ N338X Network Analyzer Family window, shown in Figure 3-3, consists of five sections.

- Server – displays the server to which Connection Manager is connected
- Select Instrument – selects and initializes the instrument from which the data is read
- Select Measurement – selects which S-parameter(s) is measured
- Export Data – saves a data file under a specific name and file type
- Save Dataset – specifies the dataset and block name under which the trace data is saved
Performing Connected Measurements

**Select Instrument**

Use this section to select and initialize the instrument used for data collection.

The drop-down list shows VISA identification strings of all instruments connected to the server. You can either select a VISA identification string from this list or type in any valid VISA identification string corresponding to an instrument connected to the server. After a new interface is created, use the Refresh button to update the instruments on the Select Instrument drop-down list.

The checkbox labeled Override instrument model check determines whether the measurement queries an instrument for its identification string and verifies that the instrument is a particular model number or belongs to a particular family. This identification takes place once at the beginning of the measurement. If you know that
a measurement needs to take place only on a certain model number of instrument or family of instruments, leave this box cleared. If you want to use an instrument whose instruction set is compatible with a given instrument or family, but is not specifically listed in the measurement, then check this box.

**Note** Measurements have only been tested with the instruments identified in the measurement window. Using an unlisted instrument may provide inaccurate results.

### Select Measurement

Use this field to select which S parameter(s) from S11, S12, S13, S21, S22, S23, S31, S32, and S33 are measured. The S11 measurement uses port 2 as load port, S22 and S33 measurements use port 1 as load port.

**Note** At least one of the checkboxes must be selected to proceed.

### Export Data

Use this section to choose a specific file name and to export an ASCII text file. Use the File Type drop-down list to choose one of two available file types – CitiFile or Touchstone.

**Note** Save Data File is only active if the Export to Text File checkbox is selected.

### Save Dataset

Use this section to specify the dataset and block name for saving trace data.

### Measure

Click the Measure button to perform the measurement. At this point data is saved in the specified dataset.
Performing Connected Measurements

**Note**  While the measurement is running, the Measurement dialog box is disabled. Upon completion, a Measurement complete dialog box appears. Click **OK** to dismiss.

**Measurement Results**

*Figure 3-4* shows typical results from a measurement performed with an Agilent E8364A, using the setup shown in *Figure 3-3.*

![Graph showing measurement results](image)

*Figure 3-4. Measurement Results Using a E8364A*
Figure 3-5 displays part of a text file generated using the Save Data File feature and the setup shown in Figure 3-3.
2-Port Power Swept S-Parameter Measurements

To access power swept S-parameter measurements choose **Measurements > 2-Port Power Swept S-Parameters** from the Connection Manager main window, shown in Figure 3-6. This measurement is available for two network analyzer families, the Agilent 8753/8722/8720/8719 Network Analyzer Family and the Agilent E88XX/E83XX/N338X PNA Series Network Analyzer Family.

![Figure 3-6. Accessing 2-Port Power Swept S-Parameter Measurements in Connection Manager](Image)
Note: The only difference between the two Power Swept S-Parameter Measurement windows is the title bar, as shown in Figure 3-7 and Figure 3-8.

Figure 3-7. 2-Port Power Swept S-Parameter Measurement - 8753/8722/8720/8719 Network Analyzer Family Window
Performing Connected Measurements

The Power Swept S-Parameter Measurement windows contain six sections:

- **Server** – displays the server to which Connection Manager is connected
- **Select Instrument** – selects and initializes the instrument from which the data is read
- **Select Power Settings** – specifies the power range over which the stimulation power is swept
- **Select Measurement** – selects which S-parameter(s) is measured
- **Export Data** – saves a data file under a specific name and file type

---

3-20 2-Port Power Swept S-Parameter Measurements
• Save Dataset – specifies the dataset and block name under which the trace data is saved

Select Instrument

Use this section to select and initialize the instrument used for data collection.

The drop-down list shows the VISA identification strings of all instruments connected to the server. You can either select a VISA identification string from this list or type in any valid VISA identification string corresponding to an instrument connected to the server. After a new interface is created, use the Refresh button to update the instruments on the Select Instrument drop-down list.

The checkbox labeled Override instrument model check determines whether the measurement queries an instrument for instrument model, its identification number or its identification string and verifies that the instrument is a particular model number or belongs to a particular family. This identification takes place once at the beginning of the measurement. If you know that a measurement needs to take place only on a certain model number of instrument or family of instruments, leave this box cleared. If you want to use an instrument whose instruction set is compatible with a given instrument or family, but is not specifically listed in the measurement, then check this box.

Note  Measurements have only been tested with the instruments identified in the measurement window. Using an unlisted instrument may provide inaccurate results.

Select Power Settings

Use this section to specify the power range over which the stimulation power is swept.

Power sweep always starts from the minimum power and ends at the maximum power. If the specified Start Power is higher than Stop Power, they are swapped.

If any of the specified power entries can not be set correctly (usually out of range) during the measurement, the measurement stops and no data file/dataset is generated.
Performing Connected Measurements

P2-P1 Power Offset can be set to a non-zero value in order to offset port 2 power from port 1 power. Only the Amplifier P2D file can reflect the power offset. Other data files and datasets only record the P1 power.

If P2-P1 Power Offset is set to a non-zero value, for example 5 dB, Agilent E88XX/E83XX/N338X Network Analyzer uncouple port 1 and port 2 automatically. However, for Agilent 8753/8722/8720/8719 Network Analyzer, port 1 and port 2 must be uncoupled manually. Otherwise, the measurement will warn out and stop.

---

**Note**  Agilent E88XX/E83XX/N338X network analyzers turn off auto attenuator control during the measurement for better accuracy.

---

Select Measurement

Use the fields in this section to select which S parameter(s) from S11, S12, S21, and S22 are measured.

---

**Note**  At least one of the checkboxes must be selected to proceed.

---

Export Data

Use this section to choose a specific file name and to export an ASCII text file.

There are five *File Type* options:

- AmplifierP2D
- AmplifierS2D
- AmpSingleCarrier
- GainRF
- All-4-Formats

Selecting a file type from the drop-down list produces a file in that format. Selecting *All-4-Formats* generates four data files, one of each type.

Entering a file name with an extension is not recommended. A .p2d, .s2d, .sc, or .txt is automatically appended to the *File name* for each of the file types respectively.
Save Dataset

Use this section to specify the dataset and block name for saving trace data.

Measure

Click the Measure button to perform the measurement. At this point data is saved in the specified dataset.

Measurement Results

Figure 3-9 shows the typical results from a measurement performed with an Agilent E8364A, using the setup shown in Figure 3-8.

![Measurement Results Using an E8364A](Figure 3-9. Measurement Results Using an E8364A)
Performing Connected Measurements

Figure 3-10 shows part of the generated MeasuredByAgilentPNA.p2d file performed with the Agilent E8364A using the setup shown in Figure 3-8.

```
E8364A  (R8 S 0.1 R 50 FC 1 0)
small signal s-parameter

B  nllx nllx nllz nllz nllz nllz nllz nllz nllz nllz nllz nllz nllz nllz nllz nllz
-6.597859E-001  5.02571E-003  -4.712100E-007
-6.597859E-001  5.02571E-003  -4.712100E-007
-6.597859E-001  5.02571E-003  -4.712100E-007
-6.597859E-001  5.02571E-003  -4.712100E-007
-6.597859E-001  5.02571E-003  -4.712100E-007
-6.597859E-001  5.02571E-003  -4.712100E-007
-6.597859E-001  5.02571E-003  -4.712100E-007
-6.597859E-001  5.02571E-003  -4.712100E-007
-6.597859E-001  5.02571E-003  -4.712100E-007
-6.597859E-001  5.02571E-003  -4.712100E-007
-6.597859E-001  5.02571E-003  -4.712100E-007
-6.597859E-001  5.02571E-003  -4.712100E-007
-6.597859E-001  5.02571E-003  -4.712100E-007
-6.597859E-001  5.02571E-003  -4.712100E-007
```

Figure 3-10. An AmplifierP2D File Generated by the Export Data Section Using an E8364A
Spectrum Measurements

Spectrum measurements are available for three spectrum analyzer families, the 856XX, 859XX, and E 444XA. To access these measurements choose **Measurements > Spectrum** in the Connection Manager Main window, then select the Analyzer Family from the submenu as shown in **Figure 3-11**.

![Figure 3-11. Accessing Spectrum Measurements in Connection Manager](image-url)
Performing Connected Measurements

Note The only differences between the three Spectrum Measurement dialog boxes are the title bars and trace names, as shown in Figure 3-12, Figure 3-13, and Figure 3-14.

Figure 3-12. Spectrum Measurement - Agilent 856XX Spectrum Analyzer Family Window

3-26 Spectrum Measurements
Figure 3-13. Spectrum Measurement - Agilent 859XX Spectrum Analyzer Family Window
Performing Connected Measurements

The Spectrum Measurement windows contain five sections.

- **Server** – displays the current Connection Manager server
- **Select Instrument** – selects and initializes the instrument from which the data is read
- **Select Frequency Settings** – specifies the frequency range over which the spectrum measurement is performed
- **Select Measurement** – selects which traces are read
- **Save Dataset** – specifies the dataset and block name under which the trace data is saved

---

3-28 Spectrum Measurements
Select Instrument

Use this section to select and initialize the instrument used for data collection.

The Select Instrument drop-down list shows the VISA identification strings of all instruments connected to the server. You can either select a VISA identification string from this list or type in any valid VISA identification string corresponding to an instrument connected to the server. After a new interface is created, use the Refresh button to update the instruments on the drop-down list.

The checkbox labeled Override instrument model check determines whether the measurement queries an instrument for its identification string and verifies that the instrument is a particular model number or belongs to a particular family. This identification takes place once at the beginning of the measurement. If you know that a measurement needs to take place only on a certain model number of instrument or family of instruments, leave this box cleared. If you want to use an instrument whose instruction set is compatible with a given instrument or family, but is not specifically listed in the measurement, then check this box.

Note Measurements have only been tested with the instruments identified in the measurement window. Using an unlisted instrument may provide inaccurate results.

If the Reset Instrument on Initialization checkbox is selected, the instrument is reset, any prior setup is lost, and the instrument returns to the factory default state. This is used in cases where the instructions a measurement sends to an instrument are not valid for the way the instrument is configured.

Select Frequency Settings

The Frequency Selection section is used to specify the frequency range over which the spectrum measurement is performed.

Selecting Use Current Instrument Settings performs a spectrum measurement over the last specified range. If the Reset Instrument on Initialization checkbox (in the Select Instrument section) is also selected, then the measurement is performed over the factory default range.

Selecting Center Frequency/ Span defines a new frequency range. The values entered in the Center Freq and Span fields and the values selected in the Units drop-down
Performing Connected Measurements

Lists must define a valid frequency range (Center Freq > 0, Span > 0, Center Freq - 0.5 × Span ≥ 0), otherwise the measurement will stop.

Selecting Start/Stop Frequency defines a new frequency range. The values entered in the Start Freq and Stop Freq fields and the values selected in the Units drop down lists must define a valid frequency range (0 ≤ Center Freq < Stop Freq), otherwise the measurement will abort.

Note: Defining a new frequency range using the Center Frequency/ Span or the Start/Stop Frequency radio buttons may return unexpected results in the case where some traces are frozen. Traces can be in two states: an update state, where each new sweep updates the trace in some way (when Clear Write, Max Hold, or Min Hold option is selected) or a frozen state, where each new sweep leaves the trace unchanged (when the View option is selected). If the View option is selected and new frequency range defined is not the same as the one with which the trace was captured before being frozen, the frequency axis of the trace read corresponds to the new frequency range and will be incorrect.

Select Measurement

The Measurement Selection area is used to select which traces are read. The Agilent 856XX family supports only two traces, whereas the Agilent 859XX and E444XA families support three traces.

Note: At least one of the checkboxes in this area must be selected to proceed.

Save Dataset

Use this section to specify the dataset and block name for saving trace data.

Measure

Click the Measure button to perform the measurement. At this point data is saved in the specified dataset.
Note While the measurement is running, the Measurement window is disabled. Upon completion a Measurement complete window appears. Click OK to dismiss this window.

Measurement Results

Figure 3-15 shows the results from a measurement performed using an Agilent E444XA and the setup shown in Figure 3-14. For this measurement, Trace1 was set to Max Hold and Trace3 was set to Min Hold.

![Figure 3-15. Traces Read Using an E444XA](image)
Voltage Waveform Measurements

Voltage waveform measurements are available for the 86100A oscilloscope and 5462x and 5464x oscilloscope families. Choose Measurements > Voltage Waveform to access the Voltage Waveform window as shown in Figure 3-16.

The measurement dialogs under this menu selection create datasets where the Y-axis values represent sampled voltage data and the X-axis values represent the times at which each voltage sample was taken.

![Figure 3-16. Accessing Voltage Waveform Measurements in Connection Manager](image)

**Note** The only the difference between the two Waveform Voltage windows are the title bar and the selections available in the Select Measurement sections, as shown in Figure 3-17 and Figure 3-18.
The Voltage Waveform Measurement windows, consist of four main sections.

- **Server** – displays the current Connection Manager server
- **Select Instrument** – selects and initializes the instrument from which the data is read
- **Select Measurement** – selects which measurement information is saved
- **Save Dataset** – specifies the dataset and block name for saving trace data
Performing Connected Measurements

Figure 3-17. Voltage Waveform Measurement – Agilent 86100A Oscilloscope Window
Select Instrument

Use this section to select and initialize the instrument used for data collection.

The drop-down list shows the VISA identification strings of all instruments connected to the server. You can either select a VISA identification string from this list or type in any valid VISA identification string corresponding to an instrument connected to the server. After a new interface is created, use the Refresh button to update the instruments on the Select Instrument drop-down list.

The checkbox labeled Override instrument model check determines whether the measurement queries an instrument for its identification string and verifies that the instrument is a particular model number or belongs to a particular family. This identification takes place once at the beginning of the measurement. If you know that a measurement needs to take place only on a certain model number of instrument or family of instruments, leave this box cleared. If you want to use an instrument whose instruction set is compatible with a given instrument or family, but is not specifically listed in the measurement, then check this box.
Performing Connected Measurements

**Note** Measurements have only been tested with the instruments identified in the measurement window. Using an unlisted instrument may provide inaccurate results.

**Select Measurement**

When stored in the dataset, each measurement selected creates a variable named according to the name assigned to the measurement, Channelx or Memoryx in the case of the Agilent 86100A oscilloscope or Channel 1 – Channel 2 in the case of the Agilent 5462x and 5464x oscilloscope families.

The Voltage Waveform Measurement – Agilent 86100A Oscilloscope dialog reads channel and memory data from an Agilent 86100A oscilloscope. Some applications use the TDR data captured by this instrument. To do this, select the channel that displays the TDR trace.

**Note** At least one of the checkboxes in this area must be selected to proceed.

**Save Dataset**

Use this section to specify the dataset and block name for saving trace data.

**Measure**

Click the Measure button to perform the measurement. At this point data is saved in the specified dataset.

**Note** While the measurement is running, the Measurement window is disabled. Upon completion a Measurement complete window appears. Click OK to dismiss.
Chapter 4: Operational and Functional Concepts

Understanding Client-Server Architecture

In its basic form, the client-server is a computational architecture involving a client process requesting a service from a server process. Client-server architecture is referred to as a logical extension of modular programming, which recognizes that software can be broken into its constituent parts for manageability purposes. With a client-server architecture this is carried a step further by acknowledging that the “modules” do not need to execute within the same memory space. This enables the client and the server to run on the hardware and software programs best suited for their individual functions. In the case of Connection Manager, this allows the server to utilize a wide variety of instrument-control capabilities only available on the Windows platform, while the client can be accessed from any platform that supports ADS.

In this architecture the client sends a message to the server, requesting that the server perform a task. The client provides the user-interface portion of the application, validates data entered by the user, sends requests to the server programs and can execute business logic.

The server program receives requests from the client, manages the interaction between the client and any connected instrumentation, retrieves and updates information, manages data integrity and dispatches responses to client requests.

Understanding the Connection Manager Server

The Connection Manager (CM) Server is the server half the Connection Manager client/server environment.

Although the server requires a version of Microsoft Windows NT or one of it’s successors, clients can exist on any platform having TCP/IP networking capabilities. It is common for clients to be on the same workstation as the server.
Operational and Functional Concepts

The Server Process Construction

The server consists of several cooperating processes. A Windows Service sets the security environment and controls the process lifetime of the other server components. The server process hierarchy is shown in Figure 4-1. The highlighted entry is the Windows Service. The subordinate process is the actual Connection Manager Server (MsmtSrvr.exe).

Note: The Process Explorer tool is available at: http://www.sysinternals.com/

The Windows Service

The process owner is listed as NT Authority\System. The System account in Windows NT is a privileged account, similar to the Super User account in UNIX.
Many Windows services are configured to run under the security context of this account.

You can configure the environment under which the Windows Service runs to restrict its access privileges to those of a particular login account. You can also configure the service to start when the server workstation boots, or require someone to specifically start it. To configure a Windows Service select Administrative Tools > Services from the Windows Control Panel. An illustration of the Services window is shown in Figure 4-2.

In the preceding illustration, the Startup Type is set to Manual. In this mode, the service requires someone to specifically start this service. When the type is set to Automatic, the service starts whenever the workstation is booted. Once a service is started, it stays running until specifically stopped. This allows a service to run and perform whatever activity it is responsible for, independent of whether other users log onto or off of the server workstation.

Note The Connection Manager server installation sets this service to start automatically.

The security environment is set in the Log On section of the Properties dialog in Windows 2000. To open this dialog:

1. Select a process (i.e., Connection Manager).
2. Choose **Action > Properties** from the Services toolbar.

3. Choose the **Log On** tab at the top of the window as shown in **Figure 4-3**.

This section determines what security environment a service and any processes it spawns uses while running. The System account, as previously stated, is very privileged. Because of this, the System account cannot use network-connected peripherals on Windows NT 4.0 (i.e., File shares). When running under the System account on Windows NT 4.0, the Windows Service or any subordinate processes are restricted from accessing files on a shared drive. This restriction does not apply to services running on Windows 2000 or Windows XP.

![Figure 4-3. Properties Window](image)

The selection labeled **This account** runs the service under the account privileges of a distinguished principle (e.g., some login account other than System). When configured this way, the server inherits the named account’s access privileges. Services running under the account privileges of a distinguished principle cannot open windows on the interactive desktop.
When the service is running, error and informational messages are reported using the Windows Event Log. To use the Event Viewer application, on Windows 2000 task bar, click **Start > Settings > Control Panel > Administrative Tools > Event Viewer**.

To view the Connection Manager event log entries, switch the Event Viewer to its Application mode and search for entries with the Source category of **AgilentConnectionManager**. This is illustrated in Figure 4-4. Figure 4-5 displays the contents of one of the Connection Manager server entries.

![Event Viewer in Windows 2000](image)

---

*Figure 4-4. Event Viewer in Windows 2000*
The Connection Manager Server

The Connection Manager Server (MsmtSrvr.exe) is a Microsoft .NET application that uses a networked interface capability called Remoting. Remoting is the ability for a Microsoft .NET component to appear as if it is running locally in a client, when it is actually running remotely in another process.

For a client to communicate with the server, they must agree on a common endpoint for the communication. With the Connection Manager server, that common end point is a network port number. A network port number is a number both parties agree on to allow conversation between a client and a particular network server. By default, the server accepts client requests on port 4790.

You can change the port number the server uses by editing the MsmtSrvr.exe.config file located in the ADS installation directory under “\ bin” (e.g., C:\ ADS2003A\ bin\ MsmtSrvr.exe.config).
The contents of the default configuration file are:

```xml
<configuration>
  <appSettings>
    <add key="port" value="4790"/>
  </appSettings>
</configuration>
```

To change the server port, change the number in the value field of the port configuration key. For example, to have the server listen on port 5885, you would change the port configuration to look like:

```xml
<add key="port" value="5885"/>
```

To have the server recognize this new value, select Agilent Connection Manager in the Services window, then choose Action to stop and restart the Windows Service as shown in Figure 4-6.

![Figure 4-6. Stopping and Restarting Services](image)
Operational and Functional Concepts

Connection Manager Server Requirements

Hardware

- PC with a Pentium III-class processor, 450 megahertz (MHz) or better
- Minimum RAM Requirements: 256 megabytes (MB)
- Hard disk space: 500 MB on system drive

Supported Instrument IO Interfaces

The supported Agilent IO interface hardware matrix can be found at:

Information on configuring the Agilent IO Libraries is available from:

Select the “IO Libraries Installation and Configuration Guide for Windows” link and go to “Configuring IO Interfaces.” This chapter has detailed configuration steps for the supported IO interfaces.

To view which version of the IO Libraries you have installed:

1. Click the Agilent IO Libraries Control task bar icon.
2. Select View Documentation > Installation and Path Information as shown below.
This brings up the following display dialog.

![Agilent I0 Libraries Installation and Path Information](image)

Information on using National Instruments IO interface cards can be found at: [http://scmkt.soco.agilent.com/field/service/signal/psa/Known_Problems/Ag_n_ni.doc](http://scmkt.soco.agilent.com/field/service/signal/psa/Known_Problems/Ag_n_ni.doc).

**Software**

**Operating Systems**

- Windows NT 4.0, Service Pack 6a
- Windows 2000 Professional, Service Pack 2
- Windows XP Professional, Service Pack 1

**Note**  The operating system must be configured for TCP/IP networking.

**Applications**

The Connection Manager server installation installs all the software necessary to enable the ADS-supplied measurements. This includes:

- A run-time version of the Agilent Test and Measurement Programmer's Toolkit. This includes the most recent version of Visa COM available when the Toolkit was released. The latest version is available from the Agilent Developer Network at: [http://adn.tm.agilent.com/](http://adn.tm.agilent.com/).
- The Agilent IO Libraries.
Operational and Functional Concepts

- Plug and Play drivers – these are also available from the Agilent Developer Network.
- The run-time version of Microsoft .NET suitable for running .NET applications.
- The Connection Manager server debian, which contains and controls the Windows service.

Removing the Connection Manager Server from the Server Workstation

1. Uninstall ADS from the server workstation by selecting Start > Programs > Advanced Design System 2003A > Uninstall ADS from the Windows task bar. This stops the Windows service and removes it from the server workstation configuration.
2. Remove the Plug & Play drivers using the Add/ Remove Programs selection from the Windows Control Panel.
3. Remove the Agilent T&M Programmers Toolkit Re-distributable using the Add/ Remove Programs selection from the Windows Control Panel.
4. Remove Agilent VisaCom using the Add/ Remove Programs selection from the Windows Control Panel.
5. Remove the Agilent IO Libraries using the Add/ Remove Programs selection from the Windows Control Panel.
6. Remove the Microsoft .NET Framework using the Add/ Remove Programs selection from the Windows Control Panel.

Understanding the Connection Manager Client

Connection Manager (CM) client, is the client half of the Connection Manager client/server system and, as such, cooperates closely with the CM server. It creates ADS data sets, holds the results of S-parameter, spectrum, and voltage waveform measurements, and provides measurement panels enabling you to interact with measurements that are located on the server.

The client also provides instrument discovery by identifying instruments that are connected to your server workstation. This enables the client to easily associate a particular instrument with a particular measurement.
Note The term measurement describes functions in a server library. Generally, a measurement includes gathering physical data from one or more instruments, but is not limited to instrument control.

File Menu

The client can save and restore its session state. Connection Manager stores its session state in the project data directory as an XML file, though the session state data may be stored in a user-defined directory.

Following is an example of a Connection Manager session state file.

```xml
- <MsmtClientConfig Version="1.0" RemoteHost="localhost" Port="4790"
  ServerSelected="0">
  <InstExplorer RemoteHost="localhost" Port="4790" />
  - <Measurements>
    - <SParm8753 RemoteHost="localhost" Port="4790">
      <VisaRsrc Value="GPIB0::16::INSTR" />
      <QueryInstId Value="0" />
      - <SelectMeasurements>
        <S11Msmt Value="1" />
        <S12Msmt Value="1" />
        <S13Msmt Value="0" />
        <S21Msmt Value="1" />
        <S22Msmt Value="1" />
        <S23Msmt Value="0" />
        <S31Msmt Value="0" />
        <S32Msmt Value="0" />
        <S33Msmt Value="0" />
      </SelectMeasurements>
    </SParm8753>
    - <ExportTextFile Value="0">
      <FileType Value="0" />
    </ExportTextFile>
  </Measurements>
  <DataSetName Value="Ag8753" />
  <BlockName Value="All4" />
</MsmtClientConfig>
```
Operational and Functional Concepts

**Server Menu**
The Server menu contains a single entry that allows you to specify a connection for the remainder of the Connection Manager client session. For more information on the behavior of this menu, refer to “Selecting a Server Workstation and Connection Port” on page 2-17.

**Instruments Menu**
The Instruments menu contains entries for dynamic instrument discovery and some rudimentary interactive instrument IO.

**The Remote Instrument Explorer**
This dialog queries connected instruments and lists the results of the query. For more information on the Remote Instrument Explorer and the instrument discovery process, refer to “Configuring the Server IO” on page 2-2 and “Instrument Discovery” on page 3-1.

**Interactive IO**
This dialog provides some rudimentary interactive instrument IO capabilities. This capability is used in troubleshooting simple instrument connectivity problems. Selecting Server > Interactive IO opens the Interactive IO dialog box.
To communicate with a specific connected instrument, select an instrument using the Select Instrument drop-down list.

Figure 4-7. Interactive IO Dialog Box
You can select an instruction to send to the instrument by choosing from the Command or Query drop-down list or by typing a command into that same field.

**Note** The definition of the IEEE-standard commands in the Command or Query field are listed in most instrument programming manuals. These manuals can be downloaded from the Agilent Developer Network: [http://adn.tm.agilent.com](http://adn.tm.agilent.com).

You can specify a waiting period before an unsuccessful communication attempt is aborted by changing the value in the Timeout in milliseconds entry field. The default is five seconds.

Different types of instrument use different character sequences to mark the end of an instruction. The EOL Sequence drop-down list enables you to select the correct command termination for a specific instrument. Almost all new instruments use a new line character as the instruction terminator, so the default entry in the drop-down control is \n, a common representation for new line. The other termination sequences involve the use of the carriage return character, commonly represented by the \r symbol.
The Send and Receive button is used to send an instruction that results in the instrument placing an immediate response on the interface bus. Generally, this type of instruction ends with a “?” character. For example, the IEEE-488.2 standard command for an instrument identification query is *idn?. Clicking the Send and Receive button causes the server to send *idn? to the instrument then wait for the response. An example is shown in Figure 4-8.

Note This dialog can only read instrument response data that is entirely text. Attempting to read a response that contains binary data will not work.

![Interactive IO Window](image)

**Figure 4-8. Interactive IO Window**

Use the Send Command button to send a command that does not prompt a response. For example, use this button to send *.cls to clear the instrument buffer.

Use the Read Response button, to read data from an instrument independent from a transmitted instruction. Some instruments can sample continuously. To get several samples of information, send a command to start the instrument sampling, then click the Read Response button several times.
Operational and Functional Concepts

The Send Device Clear button causes the server to send the IEEE-488 bus command for Selected Device Clear. This command is a high-priority bus command (superseding ordinary instructions) that forces an instrument to abort its current function and return to an idle state in order to regain control over an instrument.

The Session History is an edit field that logs the instructions you send to an instrument and the instrument's responses to those commands. To delete the contents of this field click the Clear Session History button.

Measurements Menu

The Measurements menu contains dialogs that allow you to easily configure some simple measurements. The measurement panels roughly correspond the kind of instrument that is commonly used to make a measurement such as, an oscilloscope in the case of a voltage waveform measurement. The panels are designed to be measurement-specific, as opposed to instrument specific. For example, you might use a digitizing voltmeter to collect voltage waveform data.

Troubleshooting

Communication Problems with Older Instruments

Late model computers can send instructions faster than many vintage instruments can process them. This situation often manifests itself when the instrument returns a message that is not consistent with the measurement being made.

It is possible to slow down communications with an older instrument by running the interface through the IO Libraries LAN server, causing the instructions to be sent to the instrument at a slightly slower rate.

To send commands through the IO server, complete the following steps.

1. Run siclland.exe, located in the IO Libraries installation bin directory (i.e., \Program Files\Agilent\IO Libraries\bin) on the server workstation.
This displays the following window.

2. Run IO Config and add a Visa LAN client entry.
4. When you use the Connection Manager client to specify an instrument, select the instruments shown on the LAN interface (GPIB1 in the preceding example).

Note: Using a GPIB cable of extended length is another possible method for slowing down communications with an older instrument.

Problems with the Connection Manager Server

If you are receiving a message indicating that the server has refused the connection, the cause could be:

- Firewall software on the server workstation
- Server port in use by another process

If you suspect firewall software is responsible, contact your system administrator. If a firewall is in place, it may be necessary to have the firewall software removed or disabled.

If the client receives a message that the connection has been refused and the server becomes very slow, it is probable that the server port is being used by another process.
To verify this problem, complete the following steps:

1. From the Windows tool bar, select Start > Settings > Control Panel > Administrative Tools > Services to open the Services window.
2. Highlight Agilent Connection Manager.
3. Select Action > Stop to stop the Connection Manager service.
4. Open a Command Prompt window and type:
   \`
   netstat -a
   \`
   5. Press Enter.

This provides a list of active connections on the server workstation. If the port number used by Connection Manager is present in the Active Connections list, another process is using the Connection Manager port. If this is the case, you must either stop this process to free the port or select a new port for use by Connection Manager. To change the server’s port number, refer to “The Connection Manager Server” on page 4-6.

The Remote Instrument Explorer is not Responding

If an instrument listed in the server workstation IO configuration is not accessible (i.e., disconnected or turned off), the client’s Remote Instrument Explorer will become unresponsive.

To check for an unresponsive instrument, follow these steps:

1. Run IO Config.
2. In the IO Config dialog, highlight the TCPIP lan entry in the Configured Interfaces group box and click Edit.
3. In the LAN Client dialog, click Edit VISA Config.
4. The TCPIP dialog lists which instruments are connected to the server through the LAN.
5. Ensure that the instruments are functioning properly.

If an instrument is not functioning, you must either return it to a functional state or remove it from the IO config and restart the Connection Manager service.
Operational and Functional Concepts
Index

A
applications installed, 4-9
architecture, client-server, overview, 4-1

B
block names, using different, 2-21

C
Citifile
data formatting, 3-11
example, 3-17
clear command, device, 4-16
client
File menu, description, 4-11
functional description, 4-10
Measurement menu, 4-16
overview, 1-2
Server menu, description, 4-12
starting the, 2-15, 3-2
command terminators, 4-14
configuration file, description, 2-19

D
data, measurement
displaying, 3-9
example of exported, 3-24
exporting file types, 3-22
exporting to text file, 3-11
formatting, 3-11
device clear command, 4-16
discovery, instrument, 3-1

e
equipment
process, 1-1
EOF sequence, 4-14
error reporting in Windows, 4-4

F
feature overview, 1-1
File menu, description, 4-11
file types
power swept S-parameters, 3-22
S-parameter, 3-11, 3-15
frozen traces, using, 3-30

G
GPIB interface
See also LAN interface
configuring, 2-8
connecting instruments, 2-13
troubleshooting, 2-13

H
hardware requirements, 4-8
history log, session, 4-16
hostname
determining the server, 2-18
entering a server, 2-17

I
instruments, vintage, using, 4-16
interactive IO, 4-12

IO
configuring, 2-2
interactive dialog, 4-12
interfaces, polling available, 2-3, 2-9
libraries, documentation, 2-1
supported, 4-8
IP address
determining the server, 2-18
entering a server, 2-17

L
LAN interface
See also GPIB interface
configuring, 2-3
connecting instruments, 2-5
removing prior to GPIB interface
configuration, 2-8
troubleshooting, 2-4, 2-7
log, session history, 4-16

M
measurement dialogs, 3-15
Export Data group, 3-15
Save Dataset group, 2-20, 3-15
Select Instrument group, 2-19, 3-14
Measurement menu, 4-16
O
Overview, feature, 1-1

P
Port number
configuring the server, 2-18
determining server bound, 2-18
Process
environment, 1-1
explorer tool, 4-2

R
Remote instrument explorer
accessing the, 3-2
overview, 4-12
unresponsive, 4-19
Requirements
hardware, 4-8
software, 4-9

S
Select Measurement group, 3-15
Server
configuring the IO, 2-2
error reporting, 4-4
Functional description, 4-1, 4-6
Hostname definition, 2-17
IP address definition, 2-17
Overview, 1-1
Port number, selecting, 2-17
Port number, setting, 4-6
Preparing to configure, 2-1
Process construction, 4-2
Process explorer, 4-2
Removing from PC workstation, 4-10
Selecting, 2-17
Slow, 4-18
Starting and stopping services, 4-7
Services, starting and stopping, 4-7
Session
History log, 4-16
State, saving and recalling, 4-11
Software requirements, 4-9
S-parameters
Instruments available to measure, 3-6, 3-13
Matrix and non-matrix notation, 3-5
Measurement settings, 3-22
S-parameters (continued)
Power swept
configuring, 3-21
File types, 3-22
Instruments available to measure, 3-18
Saving trace data, 3-23
Spectrum
Frequency settings, 3-29
Instruments available to measure, 3-25
Measurement selection, 3-30
Using frozen traces, 3-30
Troubleshooting
Communications errors with vintage instruments, 4-16
Connection refused, 4-18
GPIB, 2-13
LAN, 2-4, 2-7
Remote instrument explorer, 4-19
Server, slow, 4-18

U
User interface. See client

V
Visa resource identifiers, mapping, 3-3
Listing connected, 3-3
Voltage waveform
Instruments available, 3-32
Saving trace data, 3-36

W
Windows service, 4-2